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Introduction 
The purpose of the Anguilla Disaster Statistics Metadata Catalogue is to provide a location for all 
those involved in collecting and reporting on disaster data to pool knowledge of their information.  
These include Government departments, statutory bodies, trade associations and international 
bodies. 

The advantage of having metadata pooled is that it provides a one stop shop for all agencies 
searching for appropriate information.  However, that service is only effective if the catalogue is 
adopted, updated and distributed effectively.    

This document provides a series of standard operating procedures (SOPs) that enable the 
Government of Anguilla in general and the National Statistics Office (NSO) in particular to operate a 
light touch system to ensure these advantages are realised.   

This document details various SOPs to allow for: 

• Identifying any reporting protocols and the need for data, 
• Identifying roles within the system, 
• The process for reviewing what data needs cataloguing with their metadata, 
• Cataloguing the data, 
• Quality control and review, 
• Potential transfer of metadata between catalogues and systems, 
• Update procedures. 

This document also serves as the manual for the metadata catalogue.  Training materials have been 
developed based on this document. 
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PRELIMINARIES 
Before detailing the SOP, the following context is provided to establish both the environment within 
which any metadata catalogue system exists and identify any roles. 

LINKS TO KEY PROGRAMMES 

Currently the metadatabase is targeted towards the UNESCAP disaster-related Statistics Framework 
which supports reporting to the Sendai Framework for Disaster Risk Reduction.  This framework has 
been tailored towards Anguilla’s agreed reporting priorities. 

Potentially, there are many other reporting mechanisms to which the metadata catalogue could be 
targeted.  These could include: 

• CARICOM disaster statistics, 
• CDEMA’s Damage Assessment and Needs Analysis (DANA) continuum, 
• World Bank Post Disaster Needs Assessment (PDNA) requirements,  
• Other National reporting as required. 

Many of the datasets and statistics listed in the catalogue would be useful to these mechanisms.  

EXISTING INSTITUTIONAL CAPACITY  

The SOPS described here work within the understanding of the current operation of data transfer, 
statistical and disaster related responsibilities and human, institutional and technical capital existent 
within the agencies of the Government of Anguilla and beyond.  This understanding includes: 

1. The National Statistics Department (NSD) is mandated to curate the official statistics for 
Anguilla, 

2. Other agencies hold both repositories and metadata for other data collections, 
a. Department of Physical Planning holds the national repository for Geographical 

Information Systems, including metadata, 
b. Other departments hold thematic statistics and base data for a range of items which 

are not only of use in disaster statistics reporting but for a multitude of other 
purposes, 

3. Much data has a temporal dimension and multiple time stamped versions of data or 
regularly updated datasets will exist. 

4. While NSD holds and curates the metadata catalogue, it does necessarily hold any dataset 
documented there and has no right to secondarily distribute the information unless 
agreements exist with the source agency.  

Evolution of needs 

These SOPs take into account the current situation vis-a-vis the collation of disaster statistics for 
reporting, but recommends alternative procedures for Anguilla stakeholder to discuss and make 
recommendations where future institutional arrangements may be modified to ease data transfer.  
This may need some changes in both informal agreements between departments and formal 
declarations of policy and law; completion of that process is outside the scope of the current 
consultancy but recommendations are given.  

The document tries to identify clearly where the implementation of an SOP is not already current 
practice and establish if the measure would be easy to adopt within current conditions or would 
require considerable thought and significant change in procedure and duties.   
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KEY ROLES 

Given many duties and the limited institutional capacity of the Government of Anguilla and its 
component ministries and departments, where possible the burden of metadata cataloguing has 
been absorbed within existing systems.  There are a number of roles to be identified but these are 
recommended not as new posts within government, but duties allocated to existing staffing.   

Role Recommended 
Agency/ Person 

Duties Notes 

Disaster 
Metadata 
Coordinator 

National Statistics 
Department – Chief 
Statistician 

• Oversight of programme 
• Identification of data needs 
• Overall Quality assurance 
• Sharing Access of metadata 
• Annual Review  
• Sanction any update programme 
• Determines any training needs 

for data entry and usage 

Holds the 
definitive version 
of the Metadata 
Catalogue at this 
time.   

Disaster 
Metadata 
Technical 
Staff 

2 staff at NSO 
1-2 staff at Physical 
Planning 
Department/ Lands 
and Surveys  

• Collection of metadata elements 
for entry from data providers 

• Collation of data and update of 
metadatabase 

• Maintenance of data access 
• Assists in sharing of database 

 

Data 
Providers  

A technical staff 
member who 
handles information 
management within 
their agency and has 
the authority from 
their heads of 
agency to liaise in 
this SOP 

• Identification of key data 
• Where possible formatting data 

in required structures/content 
• Provision of data 
• Documentation of metadata 

elements 
• Liaison with NSD 

 

Data Users All agencies involved 
in using data, 
including 
government, 
statutory bodies, 
private companies, 
regional and 
international 
institutions.  

• No specific duties but a role 
played to ask for sight of 
metadata and request datasets, 
and to provide input as to the 
need for any updates to the 
catalogue list.  

• Provide feedback on any errors 
of corrections in the catalogue. 

Some 
understanding of 
the scope, 
limitations and 
potential of the 
data will be 
necessary 

Oversight 
Steerage 

TBD – but 
recommend key 
departments (NSD, 
DPP, Disaster 
Management) 

• Ensure the operating procedures 
are followed 

• Maintain the network to ensure 
new or revised data are collated 
in the metadata catalogue 

• Revise SOPs as necessary 

Recommended to 
be a small group of 
key agencies only 
meeting 1-2 times 
a year possibly as 
an agenda item in 
an existing 
meeting structure 
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DESCRIPTION OF DATA CATALOGUE 

FORMAT 

The data catalogue is held in Microsoft Excel (2016 version was used to create) and is stored in an 
XSLM format which allows use of macros. 

Several cells are locked by password which should reduce corruption of the file.  The password is 
available from the Disaster Metadata Coordinator and Metadata Technical Staff. 

DESCRIPTION 

The metadatabase is structured and colour coded to help use. 

Tab Content Purpose Users 
Front page Logos, acknowledgments  Affiliation All 
Main Dublin Core standard metadata 

for all data 
Data Entry and 
Search 

All 

Geographic ISO 19115 specific metadata for 
data with Geographical reference 

Data Entry and 
Search 

All 

Statistical DDI and DCAT specific metadata 
for data with Statistical reference 

Data Entry and 
Search 

All 

Metadata Log Contains information about how 
metadata were gathered and for 
whom and indicators of metadata 
completeness 

Maintenance Metadata 
Managers 

Catalogue 
Readme 

Reference and documentation Documentation All 

Contacts List of all agencies involved in 
disaster statistics 

Data Entry and 
Search 

All 
 

Look Up Lists Options for look up lists within 
data entry sheets 

Maintenance Metadata 
Managers 

Reports Summary reports of metadata Reporting All 
Sendai 
Mapping 

Mapping of Sendai requirements 
against available datasets 

Reporting All 

Stat Mapping 
Template 

A template sheet that can be used 
to define the mapping of 
data/statistics to new reporting 
requirements 

Reporting Metadata 
Managers 

New Record Option for data entry Data Entry Metadata 
Managers 

Data to be 
identified 

Lists of datasets which have not 
been found but required for 
reporting 

Maintenance Metadata 
Managers 

 

A separate tab for Statistical Variables (where individual variables could be documented more 
completely) has been removed. 
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DATA ENTRY 
• Fields in the four yellow tabs allow metadata to be entered and used in searches.   

o MAIN, GEOGRAPHICAL, STATISTICAL, METADATA LOG, 
• The information to be entered is based on the Proposed Metadata Schema document, 
• Where feasible, the values to be entered in each column can be restricted by a drop down 

list or data formatting (e.g. a date or numerical value only).   
o The lists in the drop down menu are maintained mainly in the Look Up Lists (except 

for the contacts list) and additional values can be added during a data entry session 
and the values will be updated automatically in the relevant data entry column.  

• There is initial space for 251 records.  There is a procedure for adding new rows if there is 
the need for more datasets to ensure all validation formatting is maintained.   

QUALITY CONTROL AND GOVERNANCE 
Various procedures are available to monitor the quality of the information being held and to ensure 
the information are current including: 

1. Checking when data are expected to be updated 
2. Any changes of personnel or responsibilities 
3. Any changes to the detail of the metadata held (e.g. if it comes online).   

 

MAINTENANCE 
 

The design of the metadatabase is robust but not foolproof.  Certain limitations within Excel prohibit 
full protection.  The SOPs details methods to protect the structure and content (e.g. through 
backup).   

They also list other maintenance elements to document any changes to how data are described 

 

DATA EXPORT 
 

These tabs do not contain any protocols at present but there is an intention that data can be 
exported to other metadata formats if permitted.   

 

See the Metadata Schema document for information on how the specific elements in this database 
map to international schema requirements.  
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DEFINITIONS  OF TERMS USED IN THIS MANUAL 
• Cell – the individual box where one piece of information is stored, 
• Row – a horizontal collection of cells, 
• Column – a vertical collection of cells, 
• Table – a collection of cells in rows and columns within the spreadsheet which share 

features (e.g. a look up list) , 
• Click – use the left hand mouse button to click, 
• Right Click – use the right hand mouse button to click, 
• Select – choose one of the options in the list provided (e.g. menu), 
• Type – use the keyboard to enter data, 
• Choose – use the selection, 
• Scroll – use the mouse to go up and down a list of items or position on the screen, 
• Click and drag – Left hand click with the mouse but keep button depressed then drag the 

cursor across the screen to desired location (useful for copying multiple values across 
several cells), 

• Ribbon – this is the strip across the top of the Excel window.  It contains various Tabs and 
menu options are spread across the window  for each tab, 

• WorkSheets – these are the different columns and rows  (e.g. MAIN, STATISTICAL, LOOK UP 
LISTS) which contain the information and are accessed by a series of tabs at the foot of the 
spreadsheet.  

Overview of Metadata capture process 
The following is a schematic of the process for capturing metadata for Disaster Statistics.  Each box is 
covered within the SOPs below.   
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Standard Operating Procedures 

IDENTIFICATION OF REPORTING NEEDS 

To be completed by: Disaster Metadata Coordinator in discussion with the Steering group 

AIM: 
To identify any additional datasets required for national, regional for international reporting when 
new requirements are highlighted. 

PROCEDURE 
1.  Review the new protocol for reporting and make a list the 

datasets required to fulfil the requirements 
2. Establish a new sheet in the metadata catalogue. 

a. Right click on STAT MAPPING TEMPLATE tab and select 
Move or Copy 

b. Tick on “Create a Copy” and copy “Before Sheet” STAT 
MAPPING TEMPLATE 

3. Populate this new sheet with the requirements for this new 
reporting protocol – list all datasets required and any notes.  

4. Review the existing metadatabase to establish: 
a. Is the dataset already captured in the metadata 

catalogue – match the dataset in the new metadata 
sheet for this protocol. 

b. Does the dataset identified as appropriate have all 
the requirements to be suitable for use in this 
report – report the level of match (Match, Fair 
Match, Fuzzy, Needs Adaptation) in the new 
metadata sheet.  

5. If the dataset is neither in the metadata catalogue nor a sufficient match for the use the 
metadata capture procedure below to obtain the dataset/metadata.  

OUTPUTS 
A new REPORTING (GREEN) sheet in the metadata catalogue which identifies the data needed for 
the new reporting  protocol, 
Depending on the outcome of the search the output will be: 

1. The dataset is already in metadata catalogue and of sufficient quality that needs no change 
2. The dataset is identified as a fuzzy match and organisations need to be approached to see if 

data are available. 
3. No data was identified as satisfying the requirements and a reach out to data providers is 

needed to establish a valid source.   

NOTES 
1.  This can be potentially created for many different reporting mechanisms including: 

a. Sendai (already created) 
b. CARICOM 
c. PDNA  
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METADATA CAPTURE – INITIAL DATA CAPTURE 

To be completed by: Disaster Metadata Technical Staff in consultation with the data provider 

AIM: 
To identify any additional datasets required for national, regional for international reporting when 
new requirements are highlighted. 

PROCEDURE 
1. From the identification of reporting needs, a dataset has been identified at needed.   
2. Reach out to all data providers to establish if any department collects the dataset.  
3. Identification of what type of data is needed - Once a dataset has been identified, reach out 

with a metadata DATA ENTRY form to the data provider.  
a. It can be self-filled in by the agency but is recommended that a metadata technical 

officer supports the form filling.  If possible, the XLSM form should be used. 
b. Identify if the dataset has any geographical aspects that need entry – e.g. 

i. Identify if the geographical dataset is a VECTOR or RASTER dataset 
ii. Can you identify the map projection and coordinates system? 

c. Identify if the dataset has any particular statistical elements which may need more 
cataloguing.  The elements that will need you to add metadata about statistical 
datasets are: 

i. There is some definition of a Total Population or universe for the dataset 
ii. There are specific sampling procedures implemented 

iii. Data have been weighted or normalised 
iv. Sampling error statistics exist 
v. There is need to document statistical definitions used.  

vi. A series of variables have been used in creating the final statistics 
4. Data capture - Go to the data entry sheet on the meta database 

a. NOTE - ADVISED THAT THIS SHEET CAN BE SEPARATE FROM THE DATABASE AND 
CAN ALSO BE USED MULTIPLE TIMES-  SAVE A NEW COPY FROM THE TEMPLATE 
FOR EACH DATASET BEING CATALOGUED. 

b. Capture as much detail from the user as possible for the metadata catalogue.  
Where possible let the data provider open the dataset and investigate/verify 
elements such as file size, content, format from the use of Windows Explorer or 
other tools. 

c. Try to work through all the schema. Always enter data according to the above 
guiding standard for MAIN, but only enter data for GEOGRAPHICAL and STATISTICAL 
tabs if the dataset contains those elements.   

d. Use the short cuts where possible to enter data: 
i. Some fields will only allow numerical or date formats.   

ii. Date Format is in dd/mm/yyyy but should correct to the format used on 
your computer (e.g. mm/dd/yyyy).  Today’s date can be quickly added by 
using CTRL + ;. 

iii. Many fields have a restricted set of options, drop down the arrow to the 
right and scroll down. Unfortunately, the auto complete does not work in 
Excel unless the value has been previously used. 

e. To complete – make sure you enter the fields in the Metadata log which keeps track 
of when the metadata were collected and by whom. 
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5. Transfer to the database: 
a. For each section (MAIN, GEOGRAPHIC, STATISTICAL, METADATA LOG) copy only the 

contents of the record (in light blue). 
b. Move to the same section tab  (MAIN, GEOGRAPHIC, STATISTICAL, METADATA LOG) 

and find the next available empty cell on the left hand side (COLUMN B for main, 
COLUMN C for the others).  Make sure you align the data you paste with the correct 
record in each row (not all data will have geographic or statistical data).  

c. Right click and choose Paste Special. 
d. Choose Transpose - this will paste all the record in the same row. 
e. Repeat for all tabs. 
f. It is important in the METADATA LOG to agree a review date, for example 1 year 

away, 5 years ahead or more frequent. 
g. Check that there are no validation errors in the dataset.  If there are go back to the 

NEW record and tab.  All validations should have occurred here but there is a 
potential for them not to be carried across, so checking is useful. 

6. Run a check on some of the reports to see the new data coming through.   
7. If you have used the NEW RECORD tab, ensure the data are deleted from this tab before you 

close the catalogue, so it is clear for the next time it is used.   It is better to save a copy of the 
individual NEW RECORD Worksheet and give a unique name to the file.   

OUTPUTS 
A new record covering each of the tabs. 

NOTES 
Note – not all fields have to be entered in the metadatabase.  However, it is recommended that the 
following guiding standard is followed: 

1.  MANDATORY– where possible enter these fields as they are required by international 
standards and are the most important data to hold. 

2. CONDITIONAL  – some fields are conditional on the data.  If you click on the column heading 
it will give you the expected condition as a tool tip. 

3. ADVISORY   - this is not an international recommendation but advised by this consultancy to 
complete if possible. 

4. OPTIONAL  – these are optional fields – good to enter if you have the information but not 
essential.  

5. AUTOMATIC FIELDS are shaded in  GREY, do not alter these and normally these will be 
protected from editing.  

If you prefer you can use the main data entry sheets to enter the data – this gives the advantage that 
new short cut methods will come available: 

1.  Values already entered can be quickly added by typing the first few letters. 
2. To type the same value as the record above in the same column hold down  CTRL  and type “ 

‘ ”. 
3. You can copy and paste values from other cells (but make sure the metadata is exactly the 

same). 
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The data entry sheet allows users to enter data about one dataset in a more user-friendly manner.  It 
is essential that you do not change the order of these fields or the data will not paste into the right 
column in the catalogue. 
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QUALITY CONTROL OF METADATA 

To be completed by: Disaster Metadata Coordinator or someone designated by them. 

AIM: 
To check the records in the metadatabase to ensure consistency. 

PROCEDURE 
1.  Obtain a list of any datasets updated since last QC check  

a. Go to the Metadata Log tab and check the Date of Original Report and Last Revision 
Dates to check if the record has been checked before the last date of a quality 
control check 

b. Make a list of all Unique Identifiers for reference.  
2. For each record in this list run through the row and look out for: 

a. Check mandatory and conditional fields contain data where necessary, 

b. Spelling mistakes. Highlight the row you want to check, use the  button in 
REVIEW tab on ribbon.  Once the row completes you will see a message saying 
“Good to Go” , 

c. Mistakes in punctuation, 
d. Where drop down look up lists have been used, ensure that the correct selection 

has been made, 
e. Check the value in the field conforms to what is expected from the metadata 

schema, 
f. That there are no validation errors. This will appear as a Warning triangle next to 

the cell. Usually these will be captured at data entry (a warning or error message will 
appear) but for some fields the validation is not as strict.   

OUTPUTS 
A cleaner and validated set of records that can be confidently published and used by all.  

NOTES 
1.  Note that unfortunately the spellchecker will not work when the sheets are protected. Use 

this procedure to unlock the sheet, but remember to relock afterwards. 
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ADDITION/ CHANGE OF ROLE/OWNERSHIP 

To be completed by: Disaster Metadata Technical Staff in consultation with the data provider, and 
on the instruction of the Disaster Metadata Coordinator and Steering group 

AIM: 
If a new organisation is identified which has data, this is how you can add the information. 

PROCEDURE 
The steering group and Disaster Metadata Coordinator may identify a new data source which comes 
from an organisation or agency which is not already logged in the contacts list. 

1.  Steering group /metadata coordinator identifies that some data is useful that may come 
from a new provider.  

2. Data Provider agency invited to be documented and to appoint a single contact name as the 
point contact for disaster related data (this can be at a technical or supervisory level on the 
decision of the supplier agency). 

3. Obtain the contact details (check any privacy issues) as follows: 
a. Organisation (full name of the organisation), 
b. Contact Name (first name and family name in that order), 
c. Type of contact information gathered (open text but can be elements such as office, 

webportal, home), 
d. Position in organisation – official role/post, 
e. Link to logo image  - if online, 
f. Physical address (PO Box if not available), 
g. Settlement Name, 
h. Administrative Area (compulsory but can use “-“ for Anguillan contacts), 
i. Post Code or Zip Code (AI2640 for Anguilla addresses), 
j. Email address (personal email preferred over generic office (i.e. not. info@xxx.ai)), 
k. Postal Address – only use if different from Physical Address, 
l. URL – website of office – use main organisation website rather than government 

website, 
m. Opening Hours – optional. 

4. Add a new record at the bottom of the list. 
5. Enter the details you have and check for any mistakes.  
6. Check the details with the agency before redistributing copies of the metadata catalogue.   
7. Go to a field related to agencies in the metadatabase (e.g. Creator) – drop down the pick list 

and check the new organisation is entered here if needed.   

OUTPUTS 
New contact details can be entered. 

NOTES 
1. To be able to add a new row to this table, you will need to unlock the workbook – see here.  
2. Context: 

a. There are three scenarios where this might occur  
i. When a new dataset/statistic is coming from an agency not already 

identified, 

mailto:info@xxx.ai
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ii. When an agency alerts the metadata coordinator that the contact will 
change, 

iii. When the metadata coordinator does an annual review. 
3. Change of personnel 

a. If there is a straightforward change of personnel within an organisation, there is only 
the need to change the name and any personal contact details (role, phone number, 
email).  Other details about the organisation will remain.  And the datasets assigned 
to that organisation will still link the to the same set of data.  
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ANNUAL REVIEW – NEW STATISTIC REQUIREMENT 

To be completed by: Disaster Metadata Technical Staff under the direction of Disaster Metadata 
Coordinator with reach out to data providers if necessary 

AIM: 
To ensure that the data in the metadata catalogue remain relevant.  

PROCEDURE 
1. Check the criteria for reporting are correct. 

a. Has there been an update to the data required for all the reporting?  If yes: 
i. Document for each reporting mechanism that has been identified: 

1. The new or reformed statistics that need reporting 
2. The dataset(s) which are needed to fulfil the statistical requirement 
3. Identification of which agency will hold the new data/be responsible 

for the statistic’s creation 
ii. In the catalogue, go to the particular Reporting Tab (e.g. Sendai mapping) 

and find where the new statistic will be entered: 
1. Insert a new row in the appropriate topic/section (or add a new 

topic/section on the end), 
2. Select a whole row where another topic/section is identified (e.g. 

row 5 (2.  Location section) and copy, 
3. Paste in your new cell – this will paste in the drop down and 

connecting look ups into this row, 
4. Update column B with the indicator/statistic to be measured, 
5. Update column C with the type of data (e.g. Number/% currency, 

time period etc), 
6. Ensure the dataset(s) related to this indicator or statistic is updated 

in the metadata catalogue,  
7. Return to the indicator and update the PRIMARY DATASET (and the 

SECONDARY DATASET) if appropriate with the data from the 
catalogue (it should appear in the Drop Down list).  The Who holds 
and Location fields should be automatically updated. 
 

OUTPUTS 
The Parameter is entered in the correct slot in the form and that the required dataset (s) hs been  
mapped to the parameter.   

NOTES 
1. To be able to add a new row to this table, you will need to unlock the workbook – see here.  
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ANNUAL REVIEW – CONTACTS 

To be completed by: Disaster Metadata Technical Staff under the direction of Disaster Metadata 
Coordinator with reach out to data providers if necessary 

AIM: 
To ensure  that the data in the metadata catalogue remain relevant.  

1. Check the contacts are up to date 
2. Check their details are correct. 

PROCEDURE 
 

1. Check the contacts are up to date 
a. Have a call around/ assessment of who is in position in each of the key responsible 

agencies, particularly those who provide data.  
b. See the detailed procedure for “ADDITION/ CHANGE OF ROLE/OWNERSHIP” if any 

changes are needed 

OUTPUTS 
Contact list tab in the Metadata Catalogue updated.   

NOTES 
NA 
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ANNUAL REVIEW – DATASET REVIEW 

To be completed by: Disaster Metadata Technical Staff under the direction of Disaster Metadata 
Coordinator with reach out to data providers if necessary 

AIM: 
To ensure the data in the metadata catalogue remain relevant.  

1. Datasets have been checked and updated.  

PROCEDURE 
1. Ensure the metadata for the datasets are up to date: 

a. Go to the Metadata Log, 
b. Look at Next Review Data column.  For each record which is highlighted in RED, this 

means the due date for review of the data has been passed, 
c. For each record: 

i. Contact the data provider and confirm if there is an updated version of 
these data. If so, check which details which may have changed.  These may 
particularly include: 

1. Title, 
2. Source, 
3. Period of Validity, 
4. Date Created (if a totally new dataset is created), 
5. Date Accepted, 
6. Date modified (if the same dataset as before just contains updates), 
7. Transfer Size, 
8. Temporal Characteristics. 

But a full check on the metadata is recommended in case the nature of the 
dataset has changed.  

ii. Update the fields which relate to the dataset, or in some cases when a 
historical record is needed, add a new record and complete the metadata in 
the normal fashion 

iii. In the metadata log – whether a new dataset or an old in a new date for 
when the dataset will be reviewed again.  

1. If a dataset has been superseded put “NA” in Next Review Date.  
The cell will turn green and can be ignored from hereon.   

Check that each of the contact details are correct.  

OUTPUTS 
1.  Quality assurance that the metadata catalogue is current 
2. Updated dates to inform the next annual review. 

NOTES 
NA 
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MODIFICATION OF THE METADATABASE SCHEMA 

This should only be done in discussion with the steering group and instruction from the Disaster 
Metadata coordinator 

AIM: 
If new elements need recording or metadata elements seen to be redundant, this procedure ensures 
that the changes are reflected through all the documentation. 

PROCEDURE 
Once a change has been agreed: 

1.  Metadata schema 
a. Identify if any addition is part of a recognised international metadata schema, and 

identify the parameters.  The metadata schema document provides links to all the 
metadata schemas used. 

b. Add the record  in the schema table as close as possible to related elements, 
identifying the following attributes for the new element. : 

Major Theme Groups the metadata elements into a small series of top level themes 
related to Description, Access, Content, Spatial Representation, and 
statistical study description. 

Sub Theme Each of these major themes may be further subdivided into sections. 
Label Simple label to be used for each element which is machine readable. 
Item Name A descriptive name for the element. 
Schema Element Source The standard schema from which the element is as exactly matched 

as possible (Dublin Core, DDI, DCAT or ISO 19115). 
Obligation The obligation on any cataloguer to document this element (Note 

this is open to change once it has been tested with real data): 
M – Mandatory – must be entered, 
O – Optional – this is an optional field, 
C – Conditional – if other fields are filled in this element must have 
data, 
H – Hierarchical, a useful metadata placeholder which relates to 
several more detailed elements but may also be a useful element in 
its own right for documentation.  

Condition terms If Obligation is C the terms of those conditions are specified here. 
Description A description of the element.  Where possible these descriptions 

come from the official schema description 
 

2. Metadata catalogue  
a. Ensure the worksheet where you are going to make changes is unprotected – see 

here. 
b. Find the same position within the list of column headings as the schema element 

above. 
c. Insert a new column – enter main theme, subtheme, label and Item name (which 

should be in the coloured boxes). 
d. Change the colour according to whether it is a mandatory (RED) , conditional (PINK)  

advisory (YELLOW) or optional (BLUE) or optional value expected. 
e. Establish any validations, and add tool tips if necessary. 
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f. If the value requires a look up table, go to LOOK UP LISTS tab,  make a table at the 
most appropriate location in this table which contains the values, make it a table 
and give it a sensible name (MD_XXX_CODE). 

g. Back at the new column, click on the first cell to contain a value  and select Data 
Validation > Settings: 

i. Change Allow to list. 
ii. Change Source to highlight the values which should appear in the drop 

down list (do not include the heading). 
iii. Press OK to set up the validation. 

h. Copy this cell, Select all the other cells in this column (down to row  250) , right click 
and select Paste Special and choose the Validation option. 

3. Update New Record (Data Entry Sheet): 
a. In the New Record tab, Insert three cells in the exact corresponding position where 

the new item is documented (i.e. under MAIN, STATISTICAL, GEOGRAPHICAL or 
METADATA RECORD)  

b.  In the original data tab where the new column is situated,  select the Item name 
and the next cell below (which contains any drop downs or other validations).  
Select Copy 

c. Go to New Record tab , right click and select Paste Special in the new empty cells, 
and select the Transpose option.   

d. Find the new description in the metadata schema for this new element and paste it 
under Description of Element.   

OUTPUTS 
The new element is properly documented in : 

• The metadata schema, 
• The catalogue record, 
• The data entry sheet.  

NOTES 
Any new columns included in the schema will require all datasets to be reviewed for any additions to 
the database.  This can be done on the next revision date.   
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ADDING NEW ROWS FOR METADATA CATALOG ENTRIES 

This should be completed by the Metadata Technical Staff 

AIM: 
To allow rows for more datasets to be catalogued.  This should be done before all the existing cells in 
the table have data entered for them.  

PROCEDURE 
1.  In the Main tab: Go to the last record 

in the table .  Ensure no data have 
been entered in this last record.   

2. Highlight the number on the left-hand 
column (see right) to select the whole 
row, right click and select Insert. 

3. Repeat (or CTRL-Y) to add more rows 

5. Click and drag this box down to cover 
both the new cells and the last cell in 
the table column, the new cells and 
the last will be pasted with 
consecutive numbers. 

6. Repeat steps 1-5 in Geographical, Statistical and 
Metadata Log Tabs, but select the first two cells (ID 
and Title)  before dragging the cursor down so that 
values in both columns are pasted.   

OUTPUTS 
New rows cross referenced between all the data tabs. 

NOTES 
1. The reason that you cannot just add records to the bottom of the existing list is that the data 

are held in Excel Tables.  If you add new rows below the table they are not included in the 
table which could compromise some reporting and searching functionality.   

2. To be able to add a new row to this table, you will need to unlock the workbook – see here.  
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ADDING NEW CHOICES FOR LOOK UP LISTS 

This should be completed by the Metadata Technical Staff on discussion with the Disaster 
Metadata Coordinator. 

AIM: 
While some options in the look up lists are established in International Metadata Standards and 
should not be deleted, there is scope for some look up lists to have additional items.  

PROCEDURE 
1. In the Data Entry Worksheet  where want add new look up value 

choices,  click on any cell in the column containing the look up list. 
2. On the Ribbon go to the Data tab> Data Validation. 
3. Under settings  - check the table name or range of values in the 

Source Tab. 
4.  In the Look up Tab click on the relevant table (there is a convenient 

menu at the top of the page) or find the relevant cells as listed in the 
Data Validation Window. 

5. Go to the last record in the table. 
6. Select  Insert > Table Row Below. 

7. Enter the new value in the empty box. 
8. Consider sorting the entire list alphabetically. 
9. Make a note of the cell of the last entry in the look up table (e.g., G9). 
10. Back in the original Data Entry Worksheet check if the additional value comes through. 
11. If not, go back to Data tab> Data Validation 

a. Check that the last value of the Source range includes the last entry in the look up 
table (e.g.  G9). 

b. Copy and paste special the validation through all the cells in that column. 

OUTPUTS 
New item in look up list for this column. 

NOTES 
1. The names of the tables relate where possible to identified names of elements within the 

relevant International Standard (e.g.  ISO 19115) and should not be changed.  Values already 
in the table should not be altered as they also reflect international standards.  

2. To be able to add a new row to this table, you will need to unlock the workbook – see here.  
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USING THE CATALOGUE - SEARCHING FOR METADATA 

This is aimed at the general data user.  

AIM: 
Finding a particular piece of information within the catalogue (e.g. name of dataset). 

PROCEDURE 
1. In the Home tab on the ribbon got to Find and Select. 
2. Type the search term in the Find Tab in the Find What box. 
3. Press Find Next  or Find All (if you think the term may occur several times).   

OUTPUTS 
• The active cell will jump to the next instance of the search term.   

NOTES 
1. This is useful to find a particular name of the dataset so you can source its location and 

metadata 
2. You can only search for data in unprotected areas of the catalogue. 
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USING THE CATALOGUE - FILTERING DATA 

This is aimed at the general data user.  

AIM: 
Within a particular column, finding all the values which match a particular search term. 

PROCEDURE 
1. For the column you want to filter go to the names of 

the fields (these are the ones colour coded 
red/yellow/pink/blue).    

2. There is a drop down 
arrow next to each cell – 
click here to show this box:  

3. Tick off all the options that 
you do not want to search for. 

4. Click OK. 

OUTPUTS 
Only those records which contain the exact match for the 
search term will show.   

This is useful for: 

1.  Identifying all the datasets connected with one 
agency (e.g. use ResponsibleAgency), 

2. Identifying datasets which satisfy a particular Subject, 
3. Showing all statistics or datasets which are Official 

Statistics, 
4. See data of the same format, 
5. Data that covers the same physical area, 
6. Data of the same type of research instrument, 
7. Data entered by the same people. 

 
 

NOTES 
1. Ticking off Select All first is usually the easiest way to prepare for then 

selecting just one option, particularly if there are many values to choose from. 
2. To reset the table so that all values show, repeat the steps above but ensure 

that Select All is ticked on.  

4. To switch off the filter you have used go to Data tab in the ribbon and deselect 
Filter.  

.  
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USING THE CATALOGUE – USING THE MAPPING TOOL 

This is aimed at the general data user.  

AIM: 
For being able to obtain an overview of what data are available to fulfil the requirements of a 
reporting format (at present only the Sendai/ UN ESCAP framework). 

PROCEDURE 
1. In the Home tab on the ribbon got to Find and Select 
2. Type the search term in the Find Tab in the Find What box 
3. Press Find Next  or Find All (if you think the term may occur several times).   

OUTPUTS 
• The active cell will jump to the next instance of the search term.   

NOTES 
1. This is useful to find a particular name of the dataset so you can source its location and 

metadata, and search within the data entry sheets for more metadata details.  
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MAINTENANCE - TEMPLATE FOR NEW PROCEDURES 

Enter who will be responsible for carrying out this procedure 

AIM: 
Summarise in a sentence the purpose of this procedure. 

PROCEDURE 
1. Make a numbered lists of the steps that will allow the procedure to be carried out 

a. Use multiple levels if a major step has several substeps. 
2. Try to be concise. 

OUTPUTS 
Give a list of any outputs which are created within the metadata catalogue or elsewhere here. 

NOTES 
Give any other explanatory notes here.  These could include: 

1. Specific guidance on what to enter in the catalogue elements 
2. Tips and tricks to help data entry  
3. Other advice and alternative methods.  

 

Use the above as a template to copy , paste and then document any new procedures which have 
been identified. Delete this paragraph. 
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MAINTENANCE – PROTECTING ELEMENTS OF THE CATALOGUE 

To be completed by: Developers and trained Disaster Metadata Technical Staff only 

AIM: 
The Excel spreadsheet contains many cells which are locked to stop mistakes and unformatting the 
database.  This describes the procedure for locking and unlocking cells and protecting the catalogue. 

The cells which are locked to most users will be: 

1. Titles and column headings in the spreadsheet, including the front page, 
2. Descriptive text, 
3. Reference information to other cells (e.g., the ID numbers or names of datasets passed 

through to several sheets), 
4. Automatic references (e.g., in the Sendai reporting), 
5. Reports. 

PROCEDURE 
 

1. Unlocking cells 

Cells are locked by default on the worksheets.  To unlock them so that data entry can 
occur: 

a. Select the cells you will allow data entry, 
b. Right click and select Format Cells, 
c. Check off the Locked box. 

2. Protect a sheet 
a. Go to Review Tab on ribbon, 
b. Select Protect Worksheet, 
c. Type Password (only use approved password on any sheet), 
d. You will be asked to retype the password, 
e. Only those unlocked cells will be available for people to edit. 

3. Unprotect a sheet (for making changes to structure or editing values in field headings etc. 
a. Go to Review tab on ribbon 
b. Select Unprotect Worksheet 
c. Type Password  
d. All cells will be available for edit.  

 

OUTPUTS 
 

Worksheets where structure, titles and other cells are protected while the areas for user data entry 
are able to be edited.  

NOTES 
1. The catalogue uses Protect Sheet throughout as this allows the cells where data can be 

entered to be unprotected while the rest of the sheet remains protected 
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2. The same password is used throughout the catalogue to protect each sheet. 
3. The password is not entered here in the manual for security reasons. 
4. When some change has been made in the catalogue and the sheets need re-protecting, 

always use the same password.   
5. The password is case sensitive. 
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Appendices 

TOP TIPS 

 

• If a value has already been entered in a column you should be able to type the first few 
letters and it will autocomplete.  

• When entering new data for a record, the left hand columns may not be showing (due to 
frozen panes).  If you go to Column A then use the tab key it will go to the left hand columns 
quickly.  

• Frozen panes often disappear when reopening an Excel Spreadsheet.  They can be easily 
reset: 

 

 
 
 
 
 
 
 

FILLING IN VALUES 

 

Guidance on what to enter is generally given in the Schema document.  In that document there are 
links to the International Standards websites which give more explanation and examples of how to 
enter data for each metadata element.   Below are selected descriptors to guide data entry.  

TOPIC 
Guidance from US Geological Survey ( https://apps.usgs.gov/thesaurus/thesaurus-
full.php?thcode=15)  

General subjects for which geospatial data may be relevant. Few, broad terms. 

biota Flora or fauna in natural environment, for example wildlife, vegetation, biological 
sciences, ecology, wilderness, sea life, wetlands, habitat, biological resources 

boundaries Legal land descriptions, for example political and administrative boundaries, 
governmental units, marine boundaries, voting districts, school districts, 
international boundaries 

climatology
Meteorolo
gyAtmosph
ere 

Processes and phenomena of the atmosphere, for example cloud cover, weather, 
climate, atmospheric conditions, climate change, precipitation 

economy Economic activities, conditions, and employment, for example production, labor, 
revenue, business, commerce, industry, tourism and ecotourism, forestry, fisheries, 
commercial or subsistence hunting, exploration and exploitation of resources such 
as minerals, oil and gas 

1. Go to cell where you 
enter data 2. View>FreezePanes> 

Freeze Panes 

https://apps.usgs.gov/thesaurus/thesaurus-full.php?thcode=15
https://apps.usgs.gov/thesaurus/thesaurus-full.php?thcode=15
https://apps.usgs.gov/thesaurus/term-simple.php?thcode=15&code=002
https://apps.usgs.gov/thesaurus/term-simple.php?thcode=15&code=003
https://apps.usgs.gov/thesaurus/term-simple.php?thcode=15&code=004
https://apps.usgs.gov/thesaurus/term-simple.php?thcode=15&code=004
https://apps.usgs.gov/thesaurus/term-simple.php?thcode=15&code=004
https://apps.usgs.gov/thesaurus/term-simple.php?thcode=15&code=004
https://apps.usgs.gov/thesaurus/term-simple.php?thcode=15&code=005
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elevation Height above or below sea level, for example altitude, bathymetry, digital elevation 
models, slope, derived products, DEMs, TINs 

environme
nt 

Environmental resources, protection and conservation, for example environmental 
pollution, waste storage and treatment, environmental impact assessment, 
monitoring environmental risk, nature reserves, landscape, water quality, air 
quality, environmental modeling 

farming Rearing of animals or cultivation of plants, for example agriculture, irrigation, 
aquaculture, plantations, herding, pests and diseases affecting crops and livestock 

geoscientifi
cInformatio
n 

Information pertaining to earth sciences, for example geophysical features and 
processes, geology, minerals, sciences dealing with the composition, structure and 
origin of the earth's rocks, risks of earthquakes, volcanic activity, landslides, gravity 
information, soils, permafrost, hydrogeology, groundwater, erosion 

health Health, health services, human ecology, and safety, for example disease and illness, 
factors affecting health, hygiene, substance abuse, mental and physical health, 
health services, health care providers, public health 

imageryBas
eMapsEart
hCover 

Base maps, for example land/earth cover, topographic maps, imagery, unclassified 
images, annotations, digital ortho imagery 

inlandWate
rs 

Inland water features, drainage systems and characteristics, for example rivers and 
glaciers, salt lakes, water utilization plans, dams, currents, floods and flood hazards, 
water quality, hydrographic charts, watersheds, wetlands, hydrography 

intelligence
Military 

Military bases, structures, activities, for example barracks, training grounds, military 
transportation, information collection 

location Positional information and services, for example addresses, geodetic networks, 
geodetic control points, postal zones and services, place names, geographic names 

oceans Features and characteristics of salt water bodies (excluding inland waters), for 
example tides, tidal waves, coastal information, reefs, maritime, outer continental 
shelf submerged lands, shoreline 

planningCa
dastre 

Information used for appropriate actions for future use of the land, for example 
land use maps, zoning maps, cadastral surveys, land ownership, parcels, easements, 
tax maps, federal land ownership status, public land conveyance records 

society Characteristics of society and culture, for example settlements, housing, 
anthropology, archaeology, education, traditional beliefs, manners and customs, 
demographic data, tourism, recreational areas and activities, parks, recreational 
trails, historical sites, cultural resources, social impact assessments, crime and 
justice, law enforcement, census information, immigration, ethnicity 

structure Man-made construction, for example buildings, museums, churches, factories, 
housing, monuments, shops, towers, building footprints, architectural and 
structural plans 

transportat
ion 

Means and aids for conveying persons or goods, for example roads, 
airports/airstrips, shipping routes, tunnels nautical charts, vehicle or vessel location, 
aeronautical charts, railways 

utilitiesCo
mmunicati
on 

Energy, water and waste systems and communications infrastructure and services, 
for example hydroelectricity, geothermal, solar and nuclear sources of energy, 
water purification and distribution, sewage collection and disposal, electricity and 
gas distribution, data communication, telecommunication, radio, communication 
networks 

 

https://apps.usgs.gov/thesaurus/term-simple.php?thcode=15&code=006
https://apps.usgs.gov/thesaurus/term-simple.php?thcode=15&code=007
https://apps.usgs.gov/thesaurus/term-simple.php?thcode=15&code=007
https://apps.usgs.gov/thesaurus/term-simple.php?thcode=15&code=001
https://apps.usgs.gov/thesaurus/term-simple.php?thcode=15&code=008
https://apps.usgs.gov/thesaurus/term-simple.php?thcode=15&code=008
https://apps.usgs.gov/thesaurus/term-simple.php?thcode=15&code=008
https://apps.usgs.gov/thesaurus/term-simple.php?thcode=15&code=009
https://apps.usgs.gov/thesaurus/term-simple.php?thcode=15&code=010
https://apps.usgs.gov/thesaurus/term-simple.php?thcode=15&code=010
https://apps.usgs.gov/thesaurus/term-simple.php?thcode=15&code=010
https://apps.usgs.gov/thesaurus/term-simple.php?thcode=15&code=012
https://apps.usgs.gov/thesaurus/term-simple.php?thcode=15&code=012
https://apps.usgs.gov/thesaurus/term-simple.php?thcode=15&code=011
https://apps.usgs.gov/thesaurus/term-simple.php?thcode=15&code=011
https://apps.usgs.gov/thesaurus/term-simple.php?thcode=15&code=013
https://apps.usgs.gov/thesaurus/term-simple.php?thcode=15&code=014
https://apps.usgs.gov/thesaurus/term-simple.php?thcode=15&code=015
https://apps.usgs.gov/thesaurus/term-simple.php?thcode=15&code=015
https://apps.usgs.gov/thesaurus/term-simple.php?thcode=15&code=016
https://apps.usgs.gov/thesaurus/term-simple.php?thcode=15&code=017
https://apps.usgs.gov/thesaurus/term-simple.php?thcode=15&code=018
https://apps.usgs.gov/thesaurus/term-simple.php?thcode=15&code=018
https://apps.usgs.gov/thesaurus/term-simple.php?thcode=15&code=019
https://apps.usgs.gov/thesaurus/term-simple.php?thcode=15&code=019
https://apps.usgs.gov/thesaurus/term-simple.php?thcode=15&code=019
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